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 انجبة الأٔل

 انًمذيخ

 

اِىب١ٔبد الاهع ٚصوٚارٙب اٌـج١وخ فجلأ ط١بكاً ٠مزبد هٍٝ  ٌلاٍزفبكح ِٓثىً اٌـوق ٠َوٝ الإَٔبْ 

ا١ٌّبٖ، ٌنٌه وً ٘نا ٘ٛ  اٌضّبه، ٚأٍبًاٌىبئٕبد اٌزٟ رزغنٜ هٍٝ هشت الأهع ٚربهح ٠ؤوً ِٓ 

٠غت ه١ٍٕب اٌؾفبف ه١ٍٙب ٚاٌؾل ِٓ و١ّخ اٌٙله ف١ٙب، وّب ٠غت ه١ٍٕب اٍزقلاِٙب ٚالاٍزفبكح ِٕٙب فٟ 

 ع١ّن إٌٛاؽٟ اٌّقزٍفخ.

فؤطجؼ ٠وزّل ه١ٍٙب فٟ ع١ّن  ،رـٛه اٌيِٓ ِن ٚص١مبً اهرجبؿبالإَٔبْ ثبٌوٍَٛ ٚاٌزىٌٕٛٛع١ب  اهرجؾ 

َ اٌّوٍِٛبد اٌغغواف١خ وؤؽل اٌوٍٛٔلُ  اٍزقلاَْ فٟ ٚثلأ الإَٔب ِٚزـٍجبرٙب،ٔٛاؽٟ اٌؾ١بح 

 .وٍِٛبد ٚرقي٠ٕٙب فٟ لٛاهل ث١بٔبداٌّ ٚرظ١ٕف ٚافزيايٌزٕل١ُ  ٚاٌزـج١مبد اٌزٟ رٛفو ؿولبً

 ٝروزجو ٔلُ اٌّوٍِٛبد اٌغغواف١خ أؽل أُ٘ اٌوٍَٛ اٌؾل٠ضخ اٌزٟ رـٛهد ِن ِوٚه اٌيِٓ ؽز

روًّ هٍٝ  ثؾ١ش أٙب فٟ اٌّشبه٠ن إٌٙل١ٍخ ، اٌمواه رقبما هٍٝفٟ اٌَّبهلح أطجؾذ هبِلًا ِّٙبً 

، وّب  كفبي ِٚوبٌغخ ٚرؾ١ًٍ ٚهوع ٚافواط اٌّوٍِٛبد اٌّىب١ٔخ ٚاٌٛطف١خ لأ٘لاف ِؾلكحاعّن ٚ

ٛق ٚاك أٚ مبَ ف٘ٛ أشبء ٕ٘لٍٟ ٠ُٚاٌَل  اٌّٛالن إٌّبٍجخ لإٔشبء اٌَلٚك ز١بهفافٟ أٔٙب رَُبهل 

ٚهبكح ِب ٠زُ  الإَٔبْ،ِٓ أللَ إٌّشآد اٌّبئ١خ اٌزٟ هوفٙب  ٟ٘ٚ ،ِٕقفغ ثٙلف ؽغي ا١ٌّبٖ

٠زُ  ،ٙب ٚالأ٘لاف اٌزٟ ش١لد ِٓ أعٍٙبرظ١ٕفٙب ؽَت أشىبٌٙب ٚاٌّٛاك اٌزٟ اٍزقلِذ فٟ ثٕبئ

ٚمٌه لأٔٙب  ،لهٌٚٛع١خ١اٌٙاٌو١ٍّبد  ٍزقلاَثب افز١به ِٛالن اٌَلٚك فٟ ٔلُ اٌّوٍِٛبد اٌغغواف١خ

ُِقوطا رّىٓ ِٓ ثظٛهح  وّب أٔٙب رُوـٟ ٔزبئظ،ِمبهٔخ ثبٌـوق اٌزم١ٍل٠خ  كلخأوضو  ٌؾظٛي هٍٝ 

 .ٍو٠وخ ٍٍٚٙخ

رـج١ك اٌزؾ١ًٍ ا١ٌٙلهٌٚٛعٟ فٟ ٔلُ اٌّوٍِٛبد اٌغغواف١خ فٟ افز١به ٚاٌغوع ِٓ ٘نا اٌجؾش ٘ٛ 

 ِٛالن اٌَلٚك ٚالأؽٛاع اٌّبئ١خ ثُغ١خ الاٍزفبكح ِٓ ١ِبٖ الأِـبه ِٚشبه٠ن ؽظبك ا١ٌّبٖ.

 

اٌفظً الأٚي ِملِخ اٌجؾش ٚاٌضبٟٔ رٕبٌٕٚب  هٍٝ ٘نا إٌؾٛ ٘نا اٌجؾش هٍٝ ٍزخ فظٛي ٚلل اؽزٜٛ

ف١ٗ اٌؾل٠ش هٓ ٔلُ اٌّوٍِٛبد اٌغغواف١خ ٚشوػ اٌو١ٍّبد ا١ٌٙلهٌٚٛع١خ، ١ٍ٠ٗ اٌفظً اٌضبٌش ٚرُ 

اٌؾل٠ش ف١ٗ هٓ اٌَلٚك ٚأٔٛاهٙب ٚأ١ّ٘زٙب، أِب اٌواثن ف١ؼُ رٛػ١ؼ ِٕـمخ اٌلهاٍخ ٚالإؿبه 



 
2 

، رلاٖ اٌفظً اٌقبٌِ اٌنٞ ؽٜٛ اٌقلاطخ ٚاٌزٛط١بد، ٚأف١وا ِن رؾ١ًٍ إٌزبئظ ٌٍجؾش اٌوٍّٟ

 اٌفظً اٌَبكً فظً اٌّظبكه ٚاٌّواعن. 
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انخبَٙ جبةان                                                       

 Geographic information systemَظى انًؼهٕيبد انزغشافٛخ 

(GIS) ٙٔانتحهٛم انٓٛذسٔنٕر Hydrological Analysis  

 

 :انتؼشٚف 2-1

٘ٛ ٔلبَ لبئُ هٍٝ اٌؾبٍٛة ٠وًّ هٍٝ عّن ٚط١بٔخ ٚرقي٠ٓ ٚرؾ١ًٍ ٚافواط ٚرٛى٠ن اٌج١بٔبد 

 .ٚاٌّوٍِٛبد اٌّىب١ٔخ

ٚ٘نٖ أٔلّخ روًّ هٍٝ عّن ٚاكفبي ِٚوبٌغخ ٚرؾ١ًٍ ٚهوع ٚافواط اٌّوٍِٛبد اٌّىب١ٔخ 

ٚاٌٛطف١خ لأ٘لاف ِؾلكح، ٚرَبهل هٍٝ اٌزقـ١ؾ ٚارقبم اٌمواه ف١ّب ٠زوٍك ثبٌيهاهخ ٚرقـ١ؾ 

اٌّلْ ٚاٌزٍٛن فٟ اٌَىٓ، ثبلإػبفخ اٌٝ لواءح اٌج١ٕخ اٌزؾز١خ لأٞ ِل٠ٕخ هٓ ؿو٠ك أشبء ِب ٠َّٝ 

، ٠ُّىٕٕب ٘نا إٌلبَ ِٓ اكفبي اٌّوٍِٛبد اٌغغواف١خ )فوائؾ، طٛه ع٠ٛخ، LAYERSبد ثبٌـجم

ِوئ١بد فؼبئ١خ( ٚاٌٛطف١خ )أٍّبء، علاٚي(، ِوبٌغزٙب )رٕم١ؾٙب ِٓ اٌقـؤ(، رقي٠ٕٙب، اٍزوعبهٙب، 

اٍزفَبه٘ب، رؾ١ٍٍٙب رؾ١ًٍ ِىبٟٔ ٚاؽظبئٟ، ٚهوػٙب هٍٝ شبشخ اٌؾبٍٛة أٚ هٍٝ ٚهق فٟ شىً 

 مبه٠و، ٚهٍِٛبد ث١ب١ٔخ أٚ ِٓ فلاي اٌّٛلن الإٌىزوٟٚٔ.فوائؾ، ر

رَبهل ٔلُ اٌّوٍِٛبد اٌغغواف١خ فٟ الإعبثخ هٓ وض١و ِٓ اٌزَبإلاد اٌزٟ رقض اٌزؾل٠ل )ِب ٘ٛ 

إٌّؾ اٌيهاهٟ، ِب أٔٛام اٌّؾبط١ً إٌّبٍت ىهاهزٙب فٟ اٌٛؽلح اٌيهاه١خ( ،اٌم١بٍبد )ِب َِبؽخ 

و أجٛة اٌوٞ اٌنٞ ٠وٚٞ(، ٚاٌّٛلن )أ٠ٓ رمن اٌٛؽلح اٌيهاه١خ ، ِب ٘ٛ لـ52ٚاؽلاص١بد اٌٛؽلح 

ُِ فٟ ِٕـمخ ِب(، ٚاٌزغ١و )كهعخ ٍِٛؽخ 033أٔبث١ت اٌوٞ اٌزٟ لـو٘ب  ِبٟ٘اٌفلا١ٔخ(،ٚاٌشوؽ )

اٌولالخ ث١ٓ رٛى٠ن اٌَىبْ  ِبٟ٘(، ٚاٌزٛى٠ن إٌّـٟ )5333اٌٝ اٌوبَ  5632اٌزوثخ ِٓ هبَ 

٠ٛ٘بد اٌّزوٍمخ ثب١ٌٙلهٌٚٛع١ب )ِبما ٠ؾظً اما ىاك رغ١و رلفك ١ِبٖ ِٕٚبؿك رٛاعل ا١ٌّبٖ( ٚا١ٌَٕبه

 اٌوٞ فٟ الأٔجٛة(.

 

ِغّٛهخ ِٓ اٌّجبكة ٚاٌزم١ٕبد اٌَّزقلِخ لإٔغبى أؽل  بٔلُ اٌّوٍِٛبد اٌغغواف١خ ثؤٔٙ ٚرووف

 اٌٙلف١ٓ اٌزب١١ٌٓ أٚ و١ٍّٙب7 
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اٌوضٛه هٍٝ اٌّٛالن إٌّبٍجخ لإٔغبى ٘لف ِب، اهزّبكاً هٍٝ شوٚؽ ِٚوب١٠و ِؾلكح، ِضً  -5

اٌوضٛه هٍٝ أفؼً ِٛلن لإٔشبء ِـبه، أٚ أفؼً ِٛلن لافززبػ ِووي رغبهٞ. ٠ّٚىٓ اٌم١بَ 

 ثنٌه ثبٍزقلاَ هلك ِٓ اٌو١ٍّبد إٌّـم١خ. 

ىب١ٔخ ٌّٕـمخ اكاه٠خ، أٚ الاٍزولاَ هٓ فظبئض ِوبٌُ اٌقو٠ـخ، ِضً ِووفخ اٌىضبفخ اٌَ -5

ٍوهخ اٌّووجخ اٌَّّٛػ ثٙب هٍٝ ؿو٠ك، أٚ اٍُ طبؽت اٌومبه. ٚرٕغي ٘نٖ اٌو١ٍّبد فٟ 

أٚ اٌـو٠ك أٚ اٌومبه( ف١مَٛ ٔلبَ  الإكاه٠خالأغٍت ثبٌٕمو هٍٝ اٌّوٍُ اٌغغوافٟ )إٌّـمخ 

 اٌّوٍِٛبد اٌغغواف١خ ثبٍزقواط ٍّبرٗ ِٓ لبهلح اٌج١بٔبد اٌّوافمخ ٠ٚووػٙب. 

 7ٟ٘ٚ ٔلُ اٌّوٍِٛبد اٌغغواف١خ رغّن رم١ٕبد ٍبثمخ، ٚهصذ هٕٙب ثوغ ٚكبئفٙب ٚفظبئظٙب -

 هٍُ اٌغغواف١ب .

 فٓ هٍُ اٌقوائؾ .

 هٍُ اٌَّبؽخ .

 اٌو٠بػ١بد ٚالإؽظبء .

 الاٍزشوبه هٓ ثول .

 هٍَٛ اٌؾبٍٛة .

 انزغشافٛخ:انؼُبصش الأعبعٛخ انتٙ ٚتكٌٕ يُٓب َظبو انًؼهٕيبد 

 

 يكَٕبد َظبو انًؼهٕيبد انزغشافٛخ )1-2) شكم سلىان
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 (:GISتبسٚخ َُظى انًؼهٕيبد انزغشافٛخ ) 2-2

لبَ عْٛ ٍٕٛ ثزظ٠ٛو أزشبه ٚثبء اٌى١ٌٛوا فٟ ٌٕلْ ثبٍزوّبي ٔمبؽ ٌزّض١ً ِٛالن  5521فٟ هبَ 

ثوغ اٌؾبلاد الأفواك٠خ، لبكد كهاٍزٗ ٘نٖ اٌٝ ِووفخ رٛى٠ن ٚأزشبه اٌى١ٌٛوا ِٚٓ صُ اٌٝ ِظله 

 اٌٛثبء. 

و١ٌٛوا كٙود َٔقخ ِض١ٍخ ٌقو٠ـخ عْٛ ٍٕٛ أكٙود اٌزىزلاد ٌؾبلاد ٚثبء  5625ٚفٟ هبَ 

 فٟ ٌٕلْ. 5521

صُ شٙلد أٚائً اٌموْ اٌوشو٠ٓ رـٛهاد ٍِؾٛكخ فٟ رظ٠ٛو اٌقوائؾ ثفظٍٙب اٌٝ ؿجمبد 

Layers  وّب أكد الأثؾبس ا٠ٌٕٚٛخ اٌٝ رَو٠ن رـ٠ٛو هزبك اٌؾبٍت ِّب ٍبهل هٍٝ أشبء رـج١مبد

 .5633فوائؾ هبِخ ثبٍزقلاَ اٌؾبٍت هبَ 

ثىٕلا( ٠لهُ ِمب١٠ٌ هٍُ  اٚٔزبه٠ٛ،-فِوٍٟ فٟ )اٚربٚا  GISرُ رـ٠ٛو أٚي ٔلبَ  5635فٟ هبَ 

أٚي ٔلبَ ِوٍِٛبد عغوافٟ  CGISٚثبٌزبٌٟ أطجؼ ٔلبَ اٌّوٍِٛبد اٌىٕلٞ  57230333أهػ١خ 

 هٍّٟ. 

فٟ اٌٛلا٠بد اٌّزؾلح  URISA-أكٜ ٘نا اٌٝ أشبء عّو١خ ٔلُ اٌّوٍِٛبد اٌؾؼو٠خ ٚالإل١ّ١ٍخ 

لاَ الأهاػٟ ٚاكاهح اٌّٛاهك اٌـج١و١خ فٟ ٚلا٠خ ٠ٛ١ٔٛهن هبَ الأِو٠ى١خ، ٚثول مٌه كٙو ٔلبَ اٍزق

َ. كٍذ ٘نٖ اٌّشبه٠ن فٟ رٍه 5636َ ٚٔلبَ ٚلا٠خ ١ٕ١َِٛرب الأِو٠ى١خ لإكاهح الأهاػٟ هبَ 5634

الأ٠بَ هب١ٌخ اٌزىٍفخ ثؾ١ش لا ٠َزـ١ن الإٔفبق ه١ٍٙب غ١و الإكاهاد اٌىج١وح فٟ كٚي ِضً اٌٛلا٠بد 

 لا، اٍزوا١ٌب، ٚثو٠ـب١ٔب ٚغ١و٘ب ِٓ اٌلٚي اٌّزملِخ الأٚهٚث١خ.اٌّزؾلح الاِو٠ى١خ، وٕ

فٟ ِٕزظف اٌَجو١ٕبد رُ الارفبق هٍٝ ر١َّخ ٘نٖ إٌلُ "ٔلُ اٌّوٍِٛبد اٌغغواف١خ" أٚ 

Geographic Information System  ٔلواً ٌىضوح أٍّبء إٌلُ ٚاٌجواِظ اٌَّزقلِخ فٟ ٘نا

إٌبعؾخ ٚثّيا٠ب اػبف١خ عّوذ اٌغ١ٍ١ٓ  ٠CISل ِٓ ثواِظ اٌّغبي. فٟ أٚائً اٌضّب١ٕٔبد كٙود اٌول

الأٚي ٚاٌضبٟٔ ِزّضٍخ فٟ ارَبم اٌمبهلح اٌوو٠ؼخ ٌٍَّزقل١ِٓ ٌٕلُ اٌّوٍِٛبد اٌغغواف١خ ٚرـ٠ٛو 

ِغبي الارظبي اٌّجبشو ث١ٓ هٚاك َِٚزقلِٟ ٔلُ اٌّوٍِٛبد اٌغغواف١خ هٓ ؿو٠ك شجىبد الارظبي 

اهـبء اٌغل٠ل فٟ ٘نا اٌّغبي ِجبشوح. وّب طلهد اٌول٠ل ِٓ اٌوب١ٌّخ ٚاٌشجىبد اٌّزقظظخ فٟ 

اٌّغلّاد ٚإٌلٚاد ٚاٌّئرّواد اٌو١ٍّخ ٚاٌلٚهاد اٌّزقظظخ فٟ ٔلُ اٌّوٍِٛبد اٌغغواف١خ فلاي 

 ٘نٖ اٌفزوح.
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أِب فٟ اٌزَو١ٕبد ِٚن أزشبه أٔلّخ ٚؿوف١بد ١ٔٛ٠ىٌ ٚاٌؾٛا١ٍت اٌشقظ١خ، ٚعل اٌوشواد ِٓ 

إٌلُ ثؤٍوبه ِٕقفؼخ علاً ِمبهٔٗ ثبلأٍوبه فٟ اٌَز١ٕبد ٚاٌَجو١ٕبد. ِٚن  اٌشووبد إٌّزغخ ٌٙنٖ

هجو الإٔزؤذ ثفؼً الاٌزياَ ثّوب١٠و  GISٔٙب٠بد اٌموْ اٌوشو٠ٓ أطجؼ ِٓ اٌّّىٓ هوع ث١بٔبد 

 .ٚط١غ ٔمً عل٠لح رُ الارفبق ه١ٍٙب ٚأزشبه اٌول٠ل ِٓ اٌجوِغ١بد ِفزٛؽخ اٌّظله

 

 يكَٕبد َظى انًؼهٕيبد انزغشافٛخ: 2-3

رزؤٌف ٔلُ اٌّوٍِٛبد اٌغغواف١خ ِٓ هٕبطو أٍب١ٍخ ٟ٘ اٌّوٍِٛبد اٌّىب١ٔخ ٚاٌٛطف١خ ٚأعٙيح 

اٌؾبٍت ا٢ٌٟ ٚاٌجواِظ اٌزـج١م١خ ٚاٌمٛح اٌجشو٠خ )الأ٠لٞ اٌوبٍِخ( ٚإٌّب٘ظ اٌزٟ رَزقلَ ٌٍزؾ١ًٍ 

 اٌّىبٟٔ. ١ٍزُ اٌزوو١ي ٕ٘ب هٍٝ ثوغ ٘نٖ اٌوٕبطو.

اٌؾظٛي هٍٝ اٌّوٍِٛبد اٌّىب١ٔخ ٠زُ ثـوق هل٠لح، أؽل ٘نٖ اٌـوق رلهٝ ثبٌّوٍِٛبد الأ١ٌٚخ 

ٚٔلبَ ٚاٌزٟ ٠ّىٓ عّوٙب ثٛاٍـخ اٌَّبؽخ الأهػ١خ، ٚاٌزظ٠ٛو اٌغٛٞ، ٚالاٍزشوبه هٓ ثول، 

اٌّبٍؼ اٌؼٛئٟ، أٚ  اٌّٛالن اٌوبٌّٟ. ٠ّىٓ أ٠ؼبً اٌٍغٛء ٌّوٍِٛبد صب٠ٛٔخ ٠زُ عّوٙب ثٛاٍـخ رؾل٠ل

 ٌٛؽخ اٌزول١ُ، أٚ اٌّززجن ٌٍقـٛؽ الأرِٛبر١ىٟ. 

 

ريٚك اٌقو٠ـخ ثّوٍِٛبد اػبف١خ رلهٝ ثبٌّوٍِٛبد اٌٛطف١خ ٌزوو٠ف أٍّبء إٌّبؿك ٚاػفبء 

 رفبط١ً أوضو هٓ ٘نٖ اٌقوائؾ.

 الأرٓضح انحبعٕثٛخ ٔانجشايذ انتطجٛمٛخ: 2-4

ؽ١ش رمَٛ ثزؾ١ًٍ ِٚوبٌغخ اٌج١بٔبد اٌزٟ رُ  GISرّضً اٌؾٛا١ٍت اٌوٕظو اٌلِبغٟ فٟ ٔلبَ 

رقي٠ٕٙب فٟ لٛاهل ث١بٔبد ػقّخ. رُقيّْ ث١بٔبد ٔلبَ اٌّوٍِٛبد اٌغغواف١خ فٟ أوضو ِٓ ؿجمخ 

layer  ٚمٌه ٌٍزغٍت هٍٝ اٌّشبوً اٌزم١ٕخ إٌبعّخ هٓ ِوبٌغخ و١ّبد وج١وح ِٓ اٌّوٍِٛبد كفوخ

 ٚاؽلح.

ثٕلبَ اٌّوٍِٛبد  ًِب ٠وّاٌّوٍِٛبد اٌغغواف١خ ِٕٙب رٛعل ثواِظ رـج١م١خ هل٠لح ِقظظخ ٌٕلُ 

 .ERDASٚاٌزٟ روًّ هٍٝ ٔلبَ اٌقلا٠ب ِضً  Arc GISالارغب١٘خ ِضً 

ثؤبِظ طغ١و  ٚ٘ٛ Quantum GIS ِفزٛؽخ اٌّظله ِٓ ٘نٖ اٌجواِظ اٌجوِغ١بدرٛعل ثوغ 

٠َّؼ ٌٍَّزقلَ ثز١ٙئخ ٚأشبء اٌقوائؾ هٍٝ اٌؾبٍٛة اٌشقظٟ، وّب ٠لهُ اٌول٠ل ِٓ ط١غ اٌج١بٔبد 

 . ESRI Shape File، Geotiffِضً اٌّىب١ٔخ 
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 .GRASS GIS ،SAGA GISِفزٛؽخ اٌّظله أفوٜ ِض7ً  ثوِغ١بدرٛعل أ٠ؼب 

 

خ ) 2-5 يبد انزغشافٛ ؼًهٕ ظى ان بٛدَ   :(GISخصبئص تمُ

افواط ٚرؾ١ًٍ ٚٚاكاهح اْ ٘نا إٌلبَ اٌّوزّل هٍٝ اٌؾبٍت ا٢ٌٟ ثشىً أٍبً فٟ اكفبي ٚرقي٠ٓ 

٠َّؼ إٌلبَ ثزوعّخ اٌّٛاهك اٌـج١و١خ اٚ اٌظٕبه١خ، ٚاٌّوٍِٛبد اٌغغواف١خ اٌّورجـخ ثّقزٍف 

١ؾ خ اٌٝ شىً ثَاٌّوٍِٛبد اٌٙبئٍخ ِٓ ِظبكه هل٠لح ٚرؾ٠ٍٛٙب ثـوق ِوبٌغخ ٚرؾ٠ًٛ ِٚـبثمخ آ١ٌ

ارقبم لواهرُٙ هٕل اٌزوبًِ  اٌَّئ١ٌٚٓٚػٛػ اٌوإ٠خ ٚاٌش١ٌّٛخ، ِّب ٠ًَٙ هٍٝ ٠ز١ّي ثبلإ٠غبى ٚ

 ثؤبِظ.ِن أٞ رقـ١ؾ أٚ ِزبثوخ أٞ ِشوٚم اٚ 

 

 (:GISتطجٛمبد َظى انًؼهٕيبد انزغشافٛخ ) 2-6

اٍب١ٍب فٟ هٍّٙب هٍٝ ٔلُ اٌّوٍِٛبد  اهزّبكأغل أْ ِولُ اٌلٚي اٌّزملِخ رم١ٕب أطجؾذ روزّل 

، ٚهٍٝ الأفض فٟ اٌغٙبد ٚاٌقبطخاٌغغواف١خ ٚاكفبي ٘نٖ اٌزم١ٕخ فٟ ِولُ اٌغٙبد اٌؾى١ِٛخ 

ِجبشو ِٓ فلاي شجىبد اٌؾبٍت،  ارظبياٌزٟ رمَٛ ثزمل٠ُ اٌقلِبد اٌوبِخ، ِٚولُ ٘نٖ اٌغٙبد ٌٙب 

 فمل اٍزقلِذ ٘نٖ اٌزم١ٕخ فٟ هلح ِغبلاد شٍّذ7

رقـ١ؾ ٚأشبء اٌـوق ٚط١بٔزٙب ٚرؾل٠ل أٔٛام اٌقلِبد اٌزٟ رؾزبعٙب اٌموٜ  اصلاد:انًٕ -

 ارغب٘بدٚاٌّلْ اٌٛالوخ هٍٝ اٌـوق، ٚاٌؾظٛي هٍٝ اٌّوٍِٛبد اٌؼوٚه٠خ اٌّقزٍفخ ٌزؾل٠ل 

 ا١ٌَو ِٚوالجخ ٚرٕل١ُ اشبهاد اٌّوٚه ٚٚػن ِواوي ٚٔمبؽ اٌلٚه٠بد الأ١ِٕخ.

س ٚاٌؾوائك ٚألوة ٚأٍوم اٌـوق اٌّئك٠خ ا١ٌٙب ٚرؾل٠ل رؾل٠ل ِٛالن اٌىٛاه انكٕاسث: - 

 إٌّشآد اٌّغبٚهح، ِٚووفخ اٌّٛاك اٌّقئخ ف١ٙب، ٚرؾ١ًٍ أٍب١ٌت الإٔمبم ٚاٌٛلب٠خ.

رقي٠ٓ اٌّوٍِٛبد ٚالإِلاكاد ثبٌزؾ١ٍلاد ٚاٌج١بٔبد اٌغغواف١خ ٚاٌقوائؾ  انطجٛؼٛخ:انخشٔاد  -

 ضً اٌجؾش ٚاٌزٕم١ت هٓ اٌضوٚاد اٌـج١و١خ.اٌّزوٍمخ ثبٌلهاٍبد اٌغ١ٌٛٛع١خ اٌّقزٍفخ، ِ

رؾ١ًٍ ٚرؾ٠ًٛ اٌقوائؾ اٌّقزٍفخ اٌٝ ِوٍِٛبد ٚرـج١مبد ِف١لح رَبهل فٟ  انًذٌ:تخطٛط  -

رؾل٠ل لـن الأهاػٟ ٚاٌقلِبد ٚاٌّوافك اٌوبِخ، ٚونٌه رؾ١ًٍ شجىبد ا١ٌّبٖ ٚاٌظوف 

 اٌظؾٟ ٚاٌىٙوثبء ٚهثؾ ِقــبد اٌّلْ ثجوؼٙب.
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ٌزوثخ ٚرظ١ٕفٙب ٚرؾل٠ل أِبوٓ ا١ٌّبٖ اٌغٛف١خ فٟ اٌّشبه٠ن اٌيهاه١خ، رؾ١ًٍ ا انضساػخ: -

 ٚؽَبة إٌّزغبد ٚاكاهح اٌّياهم.

 .الارظبلادرقـ١ؾ ٚرؾ١ًٍ شجىبد اٌقـٛؽ اٌٙبرف١خ ٚأثواط ٚشجىبد  الاتصبلاد:-

رؾ١ًٍ اٌّوٍِٛبد ٚاٌج١بٔبد اٌجؾو٠خ اٌّزوٍمخ ث١ّبٖ اٌجؾبه ٚاٌىبئٕبد ٚإٌجبربد : انشٕاطئ -

 ٌجؾو٠خ، ٚرؾل٠ل أِبوٓ اٌشوبة اٌّوعب١ٔخ ٚط١ل الأٍّبن.ا

 ،اٌمّبِخفلِبد عّن  رٕل١ُ ،ا١ٌّبٖط١بٔخ شجىبد رظو٠ف  ًِض انؼبيخ:انخذيبد ٔانًشافك  -

 ،اٌّوٍِٛبدٚرٕف١ن فوائؾ  رـ٠ٛو ،اٌّلْ رقـ١ؾ ،ىهاه١خكهاٍبد  هًّ ،هٞشجىبد  رٕلُ

  .ٌٍومبهاد َِؼ

ُ اٌؾووخ اٌظؾ١خ ؽلٚك اٌقـو اٌظؾٟ ٚرم١١ثّئشواد ٚ ٚاٌزٕجئرٛلن ه ٌم ٠ًشّ :انصحخ -

الإٔغبىاد اٌزٟ رُ رؾم١مٙب وّب ٠َزقلَ فٟ كهاٍخ ِوللاد اٌي٠بكح ٚإٌمظبْ ٌىض١و ِٓ اٌّئشواد ٚ

 اٌظؾ١خ.

 ٚاٌّىب١ٔخ اٌقبطخفلاٌٗ رٛف١و اٌج١بٔبد اٌٛطف١خ  ٠ٚزُ ِٓ 7انذًٕٚغشافٙ ٔانتطٕسانغكبٌ  -

َِٚزٜٛ اٌّو١شخ ٚاٌقلِبد  ٚفئبرُٙ اٌوّو٠خ ٚفظبئظُٙ ٚأٔشـزُٙثبٌزٛى٠ن اٌغغوافٟ ٌٍَىبْ 

 ه١ٍٙب.اٌزٟ ٠ؾظٍْٛ 

 ِٚىب١ٔخ هٓرٛف١و ِوٍِٛبد ٚطف١خ  ٚاٌزٟ رز١ؼ انفمش:ثشايذ انتًُٛخ انجششٚخ ٔتخفٛف  -

اٌّملِخ ٌفئبد اٌفمواء  ٚؽغُ اٌموٚعاٌّشوٚهبد اٌلاىِخ ٌزقف١ف اٌفمو ٚونٌه ِظبكه اٌز٠ًّٛ 

 ٘نٖ اٌموٚع. ٚاٌَّزف١ل٠ٓ ِٓ

َِزٜٛ اٌّو١شخ  ِٚوٍِٛبد هٟٓٚ٘ اٌزـج١مبد اٌزٟ رز١ؼ رٛف١و ث١بٔبد  7الارتًبػٛخانخذيبد  -

ٌفئبد اٌّغزّن ِٕٚبؿك اٌؾوِبْ الاعزّبهٟ َِٚزٜٛ اٌقلِبد اٌّملِخ ٌُٙ ٚؽغُ اٌَّزف١ل٠ٓ ِٓ 

 ٘نٖ اٌقلِبد ٚو١ف١خ رٛى٠ن اٌقلِبد ٚإٌزبئظ اٌزٟ رُ اٌؾظٛي ه١ٍٙب.

 ٚؽغُ اٌوب٠ٓ١ٍِزُ رٛف١و ث١بٔبد هٓ اِبوٓ اٌزغّوبد اٌظٕبه١خ  ٔانتزبسٚخ:الأَشطخ الالتصبدٚخ  -

 .ٚفوص ر٠َٛمٙبهٓ الاٍٛاق ٚؽغُ إٌّزغبد ٚأٛاهٙب  ٚونٌه ث١بٔبدف١ٙب 

ٚافزظبطبرٙب ِٛالن اٌغٙبد اٌؾى١ِٛخ  ِٚىب١ٔخ هٓزُ رٛف١و ث١بٔبد ٚطف١خ ٠ الإداسح انحكٕيٛخ: -

 .ٚاِبوٓ رٛاعل٘بفوائؾ ٌٍزووف هٍٝ ِٛالوٙب  ٚاٍمبؿٙب هٍٝرملِٙب  اٌزٟٚاٌقلِبد 

هٓ ِٛالن رٛفو ا١ٌّبٖ  ِٚىب١ٔخ ٚفوائؾفلاي ٘نا ٠زُ اٌزـج١ك رٛف١و ث١بٔبد ٚطف١خ  ِٓ انًٛبِ: -

 اٌّزٛلن ٌٙنا اٌّقيْٚ. ٚاٌوّو اٌيِٕٟاٌَلٚك  ٚرؾل٠ل ِٛالناٌّبئٟ  ٚؽغُ اٌّقيْٚ
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ِٚظبكه اٍجبة  ِٚىب١ٔخ هٓفلاي ٘نا اٌزـج١ك رٛف١و ث١بٔبد ٚطف١خ  ٠ِٚٓزُ  انجٛئخ انغٛبحٛخ: -

اٌج١بٔبد هٓ إٌّبؿك ا١ٌَبؽ١خ َِٚزٜٛ اٌقلِبد  ٚونٌه رٛفوِٕٗ.  ٚو١ف١خ اٌزقٍضاٌج١ئٟ  اٌزٍٛس

 ِٓ ٘نا اٌمـبم. ٚؽغُ اٌوبئلادا١ٌَبؽ١خ 

ٚونٌه إٌّبؿك اٌوّوا١ٔخ  ِٚىب١ٔخ هٓفلاٌٗ رٛف١و ث١بٔبد ٚطف١خ  ٠ٚزُ ِٓ انتخطٛط انؼًشاَٙ: -

ثٙنٖ اٌّلْ اٌٝ عبٔت رٛف١و ث١بٔبد  ٚاٌمل٠ّخ ٚاٌقلِبد اٌّورجـخث١بٔبد هٓ اٌّلْ اٌؾؼبه٠خ  رٛف١و

 .ٚغ١و٘ب ٚهفض اٌجٕبء ٚاِلان اٌلٌٚخهٓ الاٚلبف 

 َِٚزٜٛ ط١بٔزٙبفلاي ٘نا اٌزـج١ك رٛف١و ث١بٔبد هٓ شجىخ اٌـوق  ٠ٚزُ ِٓ انطشق ٔانُمم: -

اٌزٟ رملِٙب ٚونٌه ث١بٔبد هٓ  ٚاٌجؾوٞ ٚاٌغٛٞ َِٚزٜٛ اٌقلِبدإٌمً اٌجوٞ  ٚونٌه ٍٚبئً

 اٌج١بٔبد اٌّزوٍمخ ثمـبم إٌمً. ٚاٌزفو٠غ ٚغ١و٘ب ِٓاٌشؾٓ 

 ِٚٛالن اٌّؾـبد٠زُ ِٓ فلاي ٘نا اٌزـج١ك رٛف١و ِىب١ٔخ ٚطف١خ هٓ شجىخ اٌىٙوثبء  انكٓشثبء: -

فوائؾ ٠زُ  ٚاٍمبؿٙب هٍٝرغـ١ٙب ثٙنٖ اٌقلِخ ٚؽغُ اٌَّزف١ل٠ٓ ِٓ ٘نٖ اٌقلِبد  ٚإٌّبؿك اٌزٟ

 ٌُ رشٍّٙب ٘نٖ اٌقلِبد. ٚإٌّبؿك اٌزِٟٓ فلاٌٙب ِووفخ إٌّبؿك اٌزٟ ٠زُ رغـ١زٙب ثٙنٖ اٌقلِخ 

لٜٛ  ا٠ٌٛت، هٍٝ-آ١ٔبً–ِووي رزجن اٌّووجبد  ٚرـ٠ٛو ٌٕلبَرظ١ُّ ِضً  أَظًخ تتجغ انًشكجبد: -

أٍـٛي ا١ٌَبهاد ٌغّن اٌمّبِخ ٚثٕبء ٔلبَ  ُرٕل١ ،اٌّوٚهؽووخ ١ٍو ١ٍبهاد  ، رزجناٌلافٍٟالأِٓ 

 .اكاهح اٌو١ٍّبد

فوائؾ  ، رٕف١نٌٍزغـ١خرظ١ُّ ٔلبَ ِىزت شىبٜٚ َِٚبهلح اٌوّلاء ِضً  ششكبد الاتصبلاد: -

    .صلاص١خ الأثوبك ٌَّؼ رغـ١خ شجىخ اهٍبي اٌغٛاي

 

 :(GISانًتحممخ يٍ اعتخذايبد َظى انًؼهٕيبد انزغشافٛخ )انفٕائذ  2-7

ر١ًَٙ ه١ٍّخ هٍُ اٌقوائؾ ِّٙب وجو ؽغّٙب ٚثللخ هب١ٌخ ؽزٝ ٠زَٕٝ ٌلأشقبص  .5

 اهّبٌُٙ. فٟاٍزقلِٙب 

ر١ًَٙ ه١ٍّخ ؽفق اٌج١بٔبد ِن اٌقوائؾ اٌؼقّخ كافً اٌؾبٍٛة ثؾ١ش ٠ّىٓ اٌٛطٛي  .5

 إٌلبَ.ِٓ اُ٘ فٛائل  ٘نٖا١ٌٙب ثٌَٙٛخ ٚاعواء اٌزول٠لاد ٌٚوً 

ؿٙب ٠ل٠ٚب ؽ١ش ٠زُ هوع بٍمأبد هٍٝ اٌقوائؾ كْٚ اٌؾبعخ اٌٝ ٌٍٙٛخ اكٙبه اٌج١ب .0

 هب١ٌخ.اٌَّزقلَ ٚثٌَٙٛخ  ٠ؾزبعٗ اٌنٞاٌج١بٔبد اٌّـٍٛثخ ٚثبٌشىً 

 اٌؾبعخ.ٌٍٙٛخ هًّ َٔـ اؽز١بؿ١خ ِٓ اٌج١بٔبد ٚاٌقوائؾ ٚاٍزقلاِٙب هٕل  .1
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ٌج١بٔبد ؽ١ش ٠مَٛ اٌىّج١ٛرو ثبٌجؾش هٓ اٌج١بٔبد اعواء ه١ٍّبد اٌجؾش كافً علاٚي ا .2

 ِلح ل١ٍٍخ علاً . فٟاٌّـٍٛثخ ٚهوػٙب 

 اٌغج١ٍخ.إٌّبؿك  فِٟٕٙب فظٛطب  ٚالاٍزفبكحصلاص١خ الأثوبك 0Dاِىب١ٔخ طٕن فوائؾ  .3

ِٓ أكٚاد اٌجؤبِظ ٌزؾ١ًٍ اٌَّبهاد  الاٍزفبكحِغبي شجىبد اٌشٛاهم ٠ّىٓ  فٟ .4

 الأَٔت.ٚافز١به 

رشىٛ ِٓ أمـبم  اٌزٟإٌّبؿك  فٟف١ّىٓ اْ رؾلك أِبوٓ اٌقًٍ  ا١ٌّبِٖغبي شجىبد  فٟ .5

 .ا١ٌّبٖ فٟ

 ثٌَٙٛخ.ٚاٌّوافك اٌزؾز١خ ف١ّىٓ اْ رؾلك اِبوٓ أَلاك  اٌّغبهِٞغبي  فٟ .6

 

 

 

 :انٓٛذسٔنٕرٙ تحهٛمان 2-8

ثؾ١ش  ،ِؾًٍ ع١ل روزجو Arc-GISاٌّزٛفوح ِٓ لجً ثؤبِظ اي  ا١ٌٙلهٌٚٛعٟ اٌزؾ١ًٍ أكٚاد

ثزؾل٠ل رَّؼ  ا١ٌٙلهٌٚٛعٟ اٌزؾ١ًٍ أكٚاد ٌلأٍـؼ،أٔٙب رٛفو ؿوق ٌٛطف اٌّىٛٔبد اٌّبك٠خ 

ا١ٌّبٖ، ٚأشبء شجىبد  ِزغّوبدؽَبة رواوُ اٌزلفك، هٍُ  الارغبٖ،اٌّظبهف، ٚرؾل٠ل رلفك 

ُّلفً.( DEMاٌولّٟ ) الاهرفبمّٔٛمط  ثبٍزقلاَاٌز١به ٚمٌه   و

                      

 (:Digital Elevation Modelانشلًٙ ) الاستفبعًَٕرد  2-9

 اٌؾل٠ضخ اٌزم١ٕبد ِٓ اٌجؾو، ٠ٚوزجوَِزٜٛ ٍـؼ  اٌٍٝـؼ الأهع ثبٌَٕجخ  اهرفبمّٔٛمط ٠ج١ٓ 

 ٌٍقوائؾ ٔبعؾبً ثل٠لًا روزجو ٚاٌزٟ هػ١خالأ هرفبهبدالا ثٕمبؽ اٌّورجـخ اٌوب١ٌخ اٌللخ ماد

ؿٛاٌٙب ٚأ اٌّغبهٞ ٚرؾل٠ل اٌزظو٠ف شجىخ اٍزقلاص فٟ اٌزم١ٍل٠خ اٌـوق هٓ اٌىٕزٛه٠خ

 حٍث: X Y Z ححىي ػلى البٍاناتٌو، َِٚبؽبرٙب

X ًالإحذاثً السٍن. 

Y الإحذاثً الصادي. 

Z النقطة ػن سطح البحر ارجفاع. 
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 :انٓٛذسٔنٕرٙ تحهٛمأدٔاد ان 2-11

 

 ( :(Fill Sinksيؼبنزخ انمٛى انشبرح فٙ الاستفبع -1

 

 الاهرفبم، وً ف١ٍخ ٌٙب ل١ّخ ٟ٘ Raster اٌولّٟ ٠ىْٛ فٟ طٛهح شجىخ فلا٠ب  الاهرفبهبدّٔٛمط 

الألً فٟ ٍٍٍَخ  الاهرفبمالأهٍٝ رظت فٟ اٌق١ٍخ ماد  الاهرفبمهٓ ٍـؼ اٌجؾو ٚاٌق١ٍخ ماد 

ِززبثوخ ٚرزٛاطً ٘نٖ اٌٍََخ اٌّززبثوخ ِٓ اهرفبم أوجو اٌٝ أطغو اٌٝ أطغو ٚ٘ىنا، فبما ِب ؽلس 

ززبثن ِضً أْ لبثٍذ ف١ٍخ ماد اهرفبم أوجو وزً ِضلًا أٚ أقفبع وج١و وؾفوح فٙنا شنٚم فٟ ٘نا اٌ

ثبٌَٕجخ ٌٍجؤبِظ ِوٕبٖ ٔٙب٠خ اٌٛاكٞ ٠ٚجلأ ثول٘ب فٟ اؽزَبة ٚاكٞ عل٠ل، ِٚب ٘ٛ فٟ اٌؾم١مخ الا 

 ٔفٌ اٌٛاكٞ ٌٚىٓ اهزوػٗ ؽفوح أٚ رً ٌنا ِٓ اٌجلا٠خ ٠غت أْ ٔمَٛ ثبىاٌخ ٘نا الاهرفبم اٌشبم أٚ

 Fill Sinks اٌَّّبح٘نٖ اٌؾفوح ٚمٌه ثبهـبئّٙب ِزٍٛؾ ل١ُ اٌقلا٠ب اٌّغبٚهح ِٓ فلاي اٌو١ٍّخ 

 ٚاٌشىً اٌزبٌٟ ٠ٛػؼ ٘نا الاِو.

 

 إصانخ انمٛى انشبرح (2-2)شكم سلى ان

 

  (Flow Direction) :انزشٚبٌ اتزبِ-2
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ٚٔلاؽق إٔٔب ٔوًّ هٍٝ َِزٜٛ اٌق١ٍخ  الاهرفبماٌغو٠بْ ٌٍقلا٠ب هٍٝ أٍبً  ارغبٖفٟ رؾل٠ل  ٠َزقلَ

ِٕٙب  اهرفبهب١ٌٌٚ هٍٝ َِزٛٞ اٌوافل ثّوٕٟ أْ وً ف١ٍخ رئكٞ اٌٝ ف١ٍخ ِغبٚهح ٌٙب رىْٛ ألً 

ٌٙب ل١ّخ ٟ٘ هلُ ِٓ  ٚوً Rasterٚاٌٍّف إٌبرظ هٓ ٘نٖ اٌو١ٍّخ ٠ىْٛ فٟ طٛهح فلا٠ب شجى١خ

 .الارغبٌٖٗ هٓ هلُ ٌٗ ِلٌٛ ٚوً 55ٚ 31ٚ 05ٚ 53ٚ 1ٚ 5ٚ 5صّب١ٔخ أهلبَ 

 

 

 

يذنٕل  جٍٛٚ أعفهًٓب شكمانانزشٚبٌ نًهف الاستفبع ٔ ٔيهف اتزبِ الاستفبعيهف  (3-2)سلى شكم ان

 .كم سلى

 

 : (Flow Accumulation) انًٛبِيُبطك تزًغ  تحذٚذ-3

فٟ ؽَبة رغّوبد اٌغو٠بْ ؽ١ش أْ إٌبرظ ٠ىْٛ ٍِف هاٍزو ثؾ١ش رؾزٛٞ وً ف١ٍخ هٍٝ  رَزقلَ 

أٞ رزغّن  ،هٓ ٘نٖ اٌق١ٍخ ٚرظت ف١ٙب اهرفبهب٘نٖ اٌم١ّخ ٟ٘ هلك اٌقلا٠ب اٌزٟ رىْٛ أوضو  ل١ّخ،

 .ف١ٙب ا١ٌّبٖ اٌَبلـخ هٍٝ ٘نٖ اٌقلا٠ب
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 اٌشىً  FlowDir_Fill1اٌّـٍٛة فٟ ٘نٖ اٌّوؽٍخ اكفبي اٌٍّف إٌبرظ هٓ ه١ٍّخ ارغبٖ اٌغو٠بْ 

 7٘نٖ اٌّوؽٍخ ٟاٌزبٌٟ ٠ٛػؼ ِب ٠زُ هٍّٗ ف

 

  (Flow Accumulation)يهف يُبطك تزًغ انًٛبِٕٚضح  4-2 سلىشكم 

 

 :Conنـ ا ػًهٛخ-4

لبَ ٠ُلٙو اٌجؤبِظ ٘نٖ إٌّبؿك  ٚؽزُٝ رؾل٠ل ِٕبؿك رغّن ا١ٌّبٖ ر Flow Accumulationفٟ 

فٟ ؽ١ٓ أٔٗ وبْ ِٓ اٌّفزوع اٌوىٌ  5ٚأهـٟ ثبلٟ إٌّبؿك اٌم١ّخ  0ثبهـبء ٘نٖ إٌّبؿك اٌولُ 

 أْ ِٕبؿك رغّن ا١ٌّبٖ ٟ٘ اٌزٟ ٠ىْٛ ٌٙب ل١ّخ ٚ٘نٖ ِب ٍٛف ٠زُ هٍّٗ فٟ ٘نٖ اٌّوؽٍخ

 

 :(Stream Order) انشتت انُٓشٚخ حغبة-5

فٟ ؽَبة اٌورت إٌٙو٠خ ِٚووفخ هلك اٌورت إٌٙو٠خ ٚهلك اٌورت ٌٍٛاكٞ هلُ ٌٗ ِلٌٛي  ٠َزقلَ

ٚرُ رٛعل ؿو٠مز١ٓ ٌؾَبة اٌورت إٌٙو٠خ ؿو٠مخ اٍز١ٍو أٚ ؿو٠مخ شو٠ف  اٌٛاكٞ،هٍٝ لٛح 

 :أكٔب٠ّٖٚىٓ اٌّمبهٔخ ث١ٓ اٌـو٠مز١ٓ فٟ اٌشىً اٍزقلاَ ؿو٠مخ اٍز١ٍو ٔلوا ٌّوٚٔزٙب 
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 ٔطشٚمخ ششٚف اعتٛهشتصُٛف انشتت حغت طشٚمخ  5-2سلى شكم 

 

 : Vectorخطٙ إنٗ يهف  Raster انشجكخ انًبئٛخ يٍ يهف شجكٙ تحٕٚم-6

    Stream to الأِو ثبٍزقلاَ Vector شجىٟ اٌٝ فـٍِٟف اٌشجىخ اٌّبئ١خ ِٓ رؾ٠ًٛ  ٠زُ

Featureٟ٘ ٚاٌّلفلاد ٌٙنٖ اٌو١ٍّخ Input Stream Feature  إٌبرظ هٓ ٚف١ٙب ٔؼن اٌٍّف

غو٠بْ ٔمَٛ ثبكفبي ٍِف ارغبٖ اٌ Input Flow Direction ٚأِبStream Orderَ اٌو١ٍّخ اٌَبثمخ

 .إٌبرظ اٌٍّف ٚاٌجؤبِظ ١ٍو١ٓ اٍُ َِٚبه

 Grid Code ٚاٌؾمً Line ٚٔٛهٗ فؾ Shapefile ٘نٖ اٌو١ٍّخ ٘ٛ ٍِف فـٟ فٟ طٛهحٔبرظ 

 .ٚ٘ٛ ٠زؼّٓ هرجخ اٌوافل

7-Snap Pour Point: 

 (طبقة الوجاري الرئٍسٍة )الولف الشبكً ػلىالحً حذدت فً الولف الخطً  طةوضغ النقْٙ 

 :Watershedانًبء  يغتزًؼبد-8

ِغوٞ ِبئٟ هئ١َٟ ِن هٚافلٖ ف١ٙب  ،١ِبٖ الاِـبه هجبهح هٓ ِٕـمخ عغواف١خ رزغّن ف١ٙب ٘ٛ 

 ،ٌٝ ِٕفن ِشزونرلفك ع١ّن ا١ٌّبٖ ا إٌّـمخ ٠َُٙأهٍٟ ِٕؾله فٟ  ٚ٘ٛ ،٠ٚؾل٘ب فؾ رم١َُ ا١ٌّبٖ

ث١ٓ َِزغّوبد ا١ٌّبٖ  هٍٝ اٌؾلٚك اٌظغ١وح، ٠ٚـٍك٠ّٚىٓ أْ رؾزٛٞ أ٠ؼب هٍٝ َِزغّوبد ا١ٌّبٖ 

 طت.أٚ ٔمـخ  ِٕفن،
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انخبنجنجبة ا  

ػٍ إَشبء ٔاختٛبس انغذٔد يذخم  

 يفٕٓو انغذ: 3-1

اٌَل ٘ٛ أشبء ٕ٘لٍٟ ٠مبَ فٛق ٚاك أٚ ِٕقفغ ثٙلف ؽغي ا١ٌّبٖ. ٚاٌَلٚك ِٓ أللَ إٌّشآد 

ٚهبكح ِب ٠زُ رظ١ٕفٙب ؽَت أشىبٌٙب ٚاٌّٛاك اٌزٟ اٍزقلِذ فٟ ثٕبئٙب  الإَٔبْ.اٌّبئ١خ اٌزٟ هوفٙب 

   ٚالأ٘لاف اٌزٟ ش١لد ِٓ أعٍٙب.

اؽل ِٓ اٌّٛاك أٚ ماد اٌوكَ اٌزواثٟ ٚاٌوكَ اْ الأٔٛام اٌشبئوخ ِٓ اٌَلٚك ٟ٘ اٌزٟ رٕشؤ ِٓ ٔٛم ٚ

اٌظقوٞ ِن لبٌت رواثٟ ، أٚ ماد اٌٛاعٙخ اٌقوٍب١ٔخ ، ٚاٌَلٚك اٌقوٍب١ٔخ اٌزٟ روزّل هٍٝ 

  اٌغبمث١خ أٚ اٌمًٛ أٚ اٌلهبِبد اٌٛال١خ.

 

ٚرَزوًّ فٟ البِخ اٌَلٚك أٔٛام ِزولكح ِٓ ِٛاك اٌجٕبء الأٍب١ٍخ ٚثظفخ فبطخ اٌزواة ٚاٌقوٍبٔخ 

اٌؾغبهح ، أِب اٌّٛاك الأفوٜ ِضً اٌـٛة ٚالأفشبة ٚاٌّوبكْ ٚالإٍفٍذ ٚاٌجلاٍز١ه ٚاٌّـبؽ ٚ

ٚغ١و٘ب ِٓ اٌّٛاك اٌغو٠جخ فٟٙ رَزقلَ هٍٝ ٔـبق ػ١ك ، ٠ٚوزّل افز١به اٌّبكح اٌزٟ ٠جٕٝ ِٕٙب 

  و٠جب.اٌَل ثظفخ أٍب١ٍخ هٍٝ الاهزجبهاد الالزظبك٠خ ؽ١ش أٔٗ ِٓ اٌّّىٓ رش١١ل اٌَل ِٓ أٞ ِبكح رم

 

٠ّٚىٓ أ٠ؼب رظ١ٕف اٌَلٚك وَلٚك رقي٠ٓ لإِلاكاد ا١ٌّبٖ ٚاٌوٞ ٚر١ٌٛل اٌـبلخ ٚاٌّلاؽخ ٚغ١و٘ب 

ِٓ الأغواع ، صُ ٍلٚك اٌؾّب٠خ ِٓ اٌف١ؼبٔبد ٍٚلٚك اٌزغن٠خ اٌغٛف١خ ٚاٌَلٚك رؾذ ٍـؼ 

ٖ الأهع ٚاٌَلٚك اٌزٟ رش١ل لأغواع فبطخ ِٚو١ٕخ. ٠ّٚىٓ أْ ٠فٟ اٌَل ثؤوضو ِٓ غوع ِٓ ٘ن

  الأغواع.

 

رّضً اٌزؼبه٠ٌ ٚاٌغ١ٌٛٛع١ب ٚإٌّبؿ ٚاٌوٛاًِ الأٍب١ٍخ فٟ روع١ؼ أفؼً اٌّيا٠ب لأٔٛام اٌَلٚك 

ؽ١ش أْ أفؼً ِٛلن ِلائُ لإلبِخ اٌَل ٘ٛ اٌّٛلن اٌؼ١ك ثبٌٛاكٞ ، اٌنٞ رىْٛ ف١ٗ اٌغ١ٌٛٛع١ب 

 ِٓ ا١ٌّبٖ. ِٕبٍجخ وؤٍبً ٌٍَل ٚإٌّـمخ اٌزٟ أِبَ اٌَل لبكهح هٍٝ رقي٠ٓ و١ّبد وج١وح
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 انغذٔد:أْـذاف  3-2

 ٠زُ هًّ اٌَلٚك ٌلأغواع اٌزب١ٌخ 7

 .ٚاٌَّى١خٚالاٍزقلاِبد اٌيهاه١خ ٚر١ّٕخ اٌضوٚح اٌؾ١ٛا١ٔخ  اٌوٞ-5

 .ِٓ اٌف١ؼبٔبد ٚاٌؾل ِٕٙب اٌؾّب٠خ-5

 .اٌـبلخ اٌىٙوثبئ١خ أزبط-0

 

 :إَٔاع انغذٔد 3-3

  حغت استفبػبتٓب إنٗ:٠ّىٓ رظ١ٕف اٌَلٚك 

 .ِزوا( 52اهرفبهٗ اٌٝ  ٠ظً) لصٛش عذ-5

 .ِزوا( 63ٚ 52اهرفبهٗ ث١ٓ  ٠ىْٛ) يتٕعط عذ-5

 (.ِزوا 63)٠ي٠ل اهرفبهٗ هٓ  ػبنٙ عذ-0

 

 إَٔاػٓب يٍ حٛج انغشض:

 رٕفٛخ:تغزٚخ  عذٔد-1

ٟٚ٘ هبكح رمبَ هٍٝ ِغبهٞ الأٚك٠خ اٌوئ١َخ ٌؾغي ١ِبٖ الأِـبه ثشىً ِئلذ اٌٝ أْ ٠زُ روش١ؾٙب 

اٌٝ اٌقياْ اٌغٛفٟ. اْ اٌزغن٠خ اٌغٛف١خ ٟ٘ اؽلٜ اٌٍٛبئً اٌو١ٍّخ ٌي٠بكح ِٛاهك ا١ٌّبٖ فٟ اٌجلاك 

ِـبه ثولح اٌمبؽٍخ. ٚفٟ إٌّبؿك اٌؾبهح اٌغبفخ ٠ّىٓ أْ ٠ي٠ل ِولي اٌزجقو هٍٝ ِولي ٘ـٛي الأ

ٚفٟ ِضً ٘نٖ اٌلوٚف فبْ  ٚاٍن.رىْٛ اٍزوّبي ا١ٌّبٖ اٌغٛف١خ ثشىً  اٌزٟإٌّبؿك  فٟأػوبف اٚ 

اٌزقي٠ٓ اٌَـؾٟ لا ٠ىْٛ ِغل٠ب ثَجت فبلل ا١ٌّبٖ اٌىج١و. ِٓ ٕ٘ب عبءد فىوح رقي٠ٓ ١ِبٖ 

 اٌف١ؼبٔبد رؾذ الأهع.

ٚلل ١ٍّذ ٘نٖ اٌو١ٍّخ ثبٌزغن٠خ اٌغٛف١خ اٌظٕبه١خ أٚ رقي٠ٓ ٚاٍزوعبم ١ِبٖ اٌقياْ اٌغٛفٟ ٚلل 

فىوح اٌزغن٠خ اٌغٛف١خ ٚاؽلح ِٓ اٌٍٛبئً اٌو١ٍّخ اٌم١ٍٍخ اٌَّزقلِخ فٟ روي٠ي ٚى٠بكح ِٛاهك  اهزجود

١خ فمل أِىٓ عٕٟ ا١ٌّبٖ فٟ الألـبه اٌغبفخ. ٚثبٍزوّبي اٌزغن٠خ اٌغٛف١خ اٌظٕبه١خ ٌٍقيأبد اٌغٛف

ٚاٌـو٠مخ هف١ظخ َٔج١ب ثبلإػبفخ اٌٝ  اٌَـؾ١خ،هلح ١ِياد ِٕٙب أْ ٍوخ رقي٠ٓ ِولُ إٌّشآد 
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فٟ  لاٍزقلاِٙبأٔٗ ٠ّىٓ رفبكٞ ِشبوً رو١ٍت اٌـ١ٓ ٚرزُ رٕم١خ اِلاكاد ا١ٌّبٖ رٕم١خ ؿج١و١خ 

 أغواع اٌشوة. ٚفٟ اٌٛلذ ٔفَٗ ٠زُ رقف١غ فبلل ا١ٌّبٖ هٓ ؿو٠ك اٌزجقو.

 انغطحٙ:انتخضٍٚ  ٔدعذ-2

ٟٚ٘ رمبَ فٟ إٌّبؿك اٌغج١ٍخ ٌزوزوع ِغبهٞ الأٚك٠خ ٌؾغي ا١ٌّبٖ اٌٝ أْ ٠زُ رفو٠غٙب فٟ فيأبد 

 ِغٙيح ٌزٛى٠وٙب هٍٝ الأؽ١بء اٌَى١ٕخ أٍفً اٌَل.

 انحًبٚخ:عذٔد-3

ِٓ رلافً ١ِبٖ اٌجؾو ٟٚ٘ رٕشب ٌٍؾل ِٓ ىؽف ١ِبٖ اٌجؾو اٌٝ إٌّبؿك اٌَى١ٕخ ٚاٌيهاه١خ 

 فظٛطبً فٟ فزواد اٌّل.

 

 :ششٔط ثُبء انغذٔد 3-4

رىّٓ فـٛهح ثٕبء اٌَل اما ٌُ ٠جٕٟ ٚفك أٌٍ ٕ٘ل١ٍخ ٚع١ٌٛٛع١خ ِو١ٕخ ؽ١ش أٔٗ هٕل رٙلِٗ ٠ئكٞ 

 اٌٝ رل١ِو ٘بئً ِٚٓ ث١ٓ ٘نٖ اٌشوٚؽ اٌو١ٍّبد اٌزب١ٌخ7

ٚٔشبؿٙب  اٌزى١ٔٛخكهاٍبد ٌـجمبد إٌّـمخ، كهاٍبد ٌـج١وخ إٌّـمخ  ًٚرشّرٕٛنٕرٛخ: دساعبد  -

 .اٌيٌياٌٟ

)ا١ٌّبٖ  ٚع١ٌٛٛع١خ١٘له ٚا١ٌّبٖ اٌَـؾ١خالأِـبه اٌَبلـخ  و١ّخ انًُطمخ:دساعبد ْٛذسٔنٕرٛخ  -

 اٌغٛف١خ(

 طجٕغشافٛخ.دساعبد  -

 ل١بً ٔفبك٠ٗ اٌزوثخ، ل١بً فٛاص اٌظقٛه. َٕٛخ:دساعبد رٕٛك -

 حغبة عؼخ انغذ انتخضُٚٛخ. -

 حغبة لٕح تحًم انغذ نهًٛبِ. -

 .اٌٛىْ اٌنارٟ ٌٍّٕشآد 7حغبة انمٕٖ انًختهفخ انًؤحشح ػهٗ يُشآد انغذٔد -

ػغؾ الأِٛاط اٌو٠ؾٟ، ػغؾ اٌوٚاٍت إٌٙو٠خ  :ضغط انًبء انٓٛذسٔعتبتٛكٙحغبة  -

 هخ أِبَ اٌَل...اٌـٛٛػاٌّ

 انٓٛذسٔنٛكٙ.الآَٛبس انمبػذ٘  -
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 انشاثغنجبة ا

 رًغ ٔتحهٛم انجٛبَبد

. 

 :غشة داسفٕس()ٔلاٚتٙ ٔعط  ٔ انذساعخيُطمخ  4-1

 

ألظٝ غوة اٌَٛكاْ ث١ٓ فـٟ ؿٛي  فٟغوة كاهفٛه ٍٚؾ ٚ زٟرُ افز١به ِٕـمخ اٌلهاٍخ ثٛلا٠ 

الأهاػٟ اٌـ١ٕ١خ ؽ١ش رىْٛ ( كهعخ شّبلًا 52-55ٚفـٟ هوع ) ( كهعخ شولب55-52ً)

 ِن كٌٚخ رشبك. اٌؾلٚك فٟ ّبء اٌغٕٛث١خ ٚاٌشول١خ ٚاٌٍٛـٝ، ٚ٘ٚاٌغج١ٍخ فٟ الأعيا

هاػٟ فزوٍّٗ ِغّٛهخ ِٓ اٌغجبي ٚاٌزلاي اٌو١ٍِخ ٚالأ ّٕـمخغواف١خ اٌأِب اٌشىً اٌوبَ ٌغ 

ٔب بفٟ ٔـبق اٌَبف ْاٌٛك٠بْ ِض7ً ٚاكٞ وغب، أىَٚ، ثبهٞ، رٌٍٛٛ، ٚرلفلا ّٙباٌيهاه١خ ٚرٕزشو ف١

عجً ِوح  ٕ٘بٌه١و١خ أشٙو اٌزؼبه٠ٌ اٌـج اٌغ١ٕخ اٌزٟ رز١ّي ثغـبئٙب إٌجبرٟ اٌغ١ل ٌٍوهٟ، ِٚٓ

اٌغـبء إٌجبرٟ اٌغ١ل، إٌجبرٟ اٌىض١ف ٚاٌغبثبد  ز١ٓفظت ِٕبؿك اٌَٛكاْ، ٠َٚٛك اٌٛلا٠اٌنٞ ٠وزجو أ

 ٚاٌّٙٛلٕٟ. اٌغ١ٕخ ثؤشغبه اٌَوٚ ٚاٌمّج١ً

اٌغ١ٕخ  ٚاٌَبفبٔبِٓ شجٗ اٌظؾواٚٞ فٟ ألظٝ اٌشّبي صُ اٌَبفٕب اٌفم١وح فٟ اٌٍٛؾ فٙب ٠زلهط ِٕب

 فٟ الأعياء اٌغٕٛث١خ ِٕٙب، ٚرز١ّي ِورفوبد عجً ِوح ثّٕبؿ اٌجؾو الأث١غ اٌّزٍٛؾ.

( ٍُِ فٟ ألظٝ اٌغٕٛة ٠ٚجلأ ٘ـٌٛٙب 533( ٍُِ فٟ ألظٝ اٌشّبي اٌٝ )553رزواٚػ الأِـبه ِٓ )

ثشزبء ثبهك ؿ٠ًٛ ِٓ أوزٛثو ؽزٝ فجوا٠و ٚط١ف لظ١و  اِْب٠ٛ ٚؽزٝ أوزٛثو، ٚرز١ّيفٟ شٙو 

 ( كهعخ ِئ٠ٛخ.52ِوزلي ِٓ ِبهً ؽزٝ ِب٠ٛ ِٚزٍٛؾ كهعخ اٌؾواهح )

 

ِٕب١ٍت ٌلأِـبه ثى١ّبد ٚف١وح ِّب أكٜ اٌٝ رٛف١و ا١ٌّبٖ اٌَـؾ١خ ِن ٚعٛك  بٌٛلا٠ز١ٓرٛعل ث

 و ِىوت ٠ٍٕٛبً.( ١ٍِبهاد ِز530) ثؾٛاٌٟأؽٛاع عٛف١خ ٠ٚمله ِوكٚك اٌٛلا٠خ اٌّبئٟ 

ب، ٟٚ٘ غبثبد ّ%( ِٓ أهاػ42ٙ١) ثؾٛاٌٟرمله  هاػٟالأبد َِبؽبد وج١وح ِٓ ٚرغـٟ اٌغبث

ؿج١و١خ رزلهط ِٓ الأشغبه اٌشٛو١خ فٟ اٌشّبي ٚالأشغبه ماد أٚهاق اٌوو٠ؼخ فٟ اٌغٕٛة ؽ١ش 

وّب ٠زُ رَٛك اٌَبفٕب اٌغ١ٕخ. ٚرَُٙ اٌغبثبد ثمله وج١و ِٓ طبكهاد اٌجلاك ِٓ اٌظّغ اٌووثٟ 

 الاٍزفبكح ِٕٙب فٟ ؽـت اٌٛلٛك ٚفؾُ اٌؾو٠ك.
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( 5.5( ِلا١٠ٓ فلاْ اٌَّزغً ِٕٙب فو١ٍبً )5) ز١ٓاٌَّبؽخ اٌظبٌؾخ ٌٍيهاهخ ثبٌٛلا٠ٚ٠جٍغ اعّبٌٟ 

فلاْ، ٚأُ٘ اٌّؾبط١ً إٌّزغخ ٟ٘ اٌلفٓ اٌنٞ ٠وزجو اٌّؾظٛي اٌوئ١َٟ اػبفخ اٌٝ اٌفٛي 

اٌجـ١ـ ٚاٌىوولٞ ٚاػبفخ ٌٍّؾظٛلاد اٌجَزب١ٔخ اٌزٟ ٠ٕزغٙب اٌَٛكأٟ ٚاٌنهح ٚاٌمّؼ ٚاٌٍٛث١ب ٚؽت 

 عجً ِوح.

ٚرمله اٌضوٚح  ػقّخ رشًّ الأثمبه ٚاٌؼؤْ ٚالإثً ٚاٌق١ٛي ٚاٌؾ١ّو، ؽ١ٛا١ٔخثضوٚح  اْوّب ريفو

 %( فٟ الالزظبك اٌمِٟٛ.55) ثؾٛاٌٟ( ِلا١٠ٓ هأً ٚرَُٙ 1.2) ثؾٛاٌٟ ف١ّٙباٌؾ١ٛا١ٔخ 

 

 

 غشة داسفٕسٔ ٔعطتٙ ٔلاٚ (1-4) سلىشكم ان
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 انؼًهٛخ:انخطٕاد  4-2

 نحصٕل ػهٗ ًَٕرد ػهٗ ًَٕرد الاستفبػبد انشلًٙ:ا 4-2-1

ٌٍَٛكاْ ِٓ ِٛلن ١٘ئخ اٌَّؼ اٌغ١ٌٛٛعٟ  DEM))اٌولّٟ  الاهرفبهبدّٔٛمط  هٍٝاٌؾظٛي  رُ

ٌمـن ِٕـمخ اٌلهاٍخ ِٓ  ،ARCGIS10.3ثؤبِظ  اٌٝ( ِٚٓ صُ رّذ اػبفزٗ USGSالأِو٠ى١خ )

 Data افز١وصُ  Arc Toolbox ٝاٌٚمٌه ثبٌن٘بة  اٌولّٟ ٌٍَٛكاْ الاهرفبهبدّٔٛمط 

Management Tools \Raster\Raster Processing\clip   

  ٌٍلهاٍخ.ٚلـن إٌّـمخ اٌزٟ افز١ود 

 GCS_WGS_1984    الحً جن الحصىل ػلٍها هؼرفة بنظام الاحذاثٍات الجغرافٍة   DEMطبقة 

الوحر( لونطقة )ب  WGS_1984_UTM_Zone_34Nوحىلث الً الوسقط الوحلً   (،)بالذرجة

 ورلك هن شرٌط الأدوات  الذراسة،

Arc toolBox اخحٍر 

Data Management Tools > Transformation and Projection > Raster > 

Project Raster 

 

 

 

 

 

 

 

 

 

 

 

 



 
21 

 

 

ًَٕرد الاستفبػبد انشلًٙ نهغٕداٌ (2-4سلى )شكم ان  

 

 

 

 
 

ًَٕرد الاستفبػبد انشلًٙ نًُطمخ انذساعخ (3-4سلى)شكم ان  

 

 : (Fill Sinks) الاستفبعيؼبنزخ انمٛى انشبرح فٙ  4-2-2

 

    ٌٍزؤول ِٓ أExtensionْ افز١بهٚرُ  Tools ثبٌن٘بة أٚلا اٌٝ لبئّخ Fill Sinks هًّرُ 

Spatial Analysis ُمٌه اٌؼغؾ ه7ٍٝ ٚثول ه١ٍٗ رفو١ٍٗ ٌٍوًّ ر 

 Arc Toolbox > Spatial Analysis > Hydrology > Fill                                  
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َّ ٍِف ّٔٛمط  Input surface raster كٙود إٌبفنح اٌزب١ٌخ أِبَ  (IMG)اٌولّٟ الاهرفبهبداُكف

َّ اٍُ َِٚبه اٌ Output surface raster ٚفٟ ٍّف إٌبرظ وّب ٠ّىٓ رؾل٠ل ألظٝ ؽل ثبٌَٕجخ اُكف

ُّ اٌٍّفاٌنٞ ٠ّىٓ اٌزوبًِ ِوٗ ٚلا ٠قزٍف اٌٍّف إٌبرظ ِٓ ؽ١ش اٌشىً هٓ  ٌلاهرفبم  لفً.اٌ

 

 انتخهص يٍ انمٛى انشبرح فٙ الاستفبعيٌذخلاد ػًهٛخ  (4-4)سلى شكم ان                 

 

 :(Flow Direction)  انزشٚبٌ اتزبِ 4-2-3

 

 ا7ٌٝ ثبٌن٘بة Flow directionرُ هًّ اٌـ 

Arc Toolbox > Spatial Analysis > Hydrology >Flow direction                       

َّ اٌٍّف إٌبرظ هٓ اٌو١ٍّخ اٌَبثمخ كٙود إٌبفنح ٚرُ  ،Input Surface rasterفٟ  اٌزب١ٌخ صُ اُكف

  Output Flow direction raster .َِٚبه اٌٍّف إٌبرظ فٟ اصُرؾل٠ل 
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 اتزبِ انزشٚبٌ  يُذخلاد ػًهٛخ (5-4) سلىشكم ان

 

 

 انذساعخ نًُطمخ flow-direction ػًم ( 6-4)سلى انشكم

 

 ٚٔقزبه٠Flow Direfulّىٕٕب فزؼ ث١بٔبد اٌٍّف ِٓ فلاي اٌؼغؾ ثيه اٌفؤهح الأ٠ّٓ هٍٝ اٌٍّف 

Open Attribute Layer   اٌزب١ٌخفزلٙو اٌشبشخ: 
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 الاتزبِنٓب ْزا  انتٙٔػذد انخلاٚب  اتزبِكم  ٕٚضح انزذٔل

 

هٍٝ اعّبٌٟ هلك اٌقلا٠ب ٌىً  رؾزٛٞ Countٚ، الارغبٖرؾزٛٞ اٌولُ اٌّوجو هٓ  Value ٠ُلاؽق أْ

ف١ٍخ ٌٙب ارغبٖ اٌشوق فٟ اٌغو٠بْ، ٌٚفُٙ ٘نٖ اٌّوؽٍخ ثظٛهح أفؼً ٠غت أْ  55151أٞ أْ  ارغبٖ

اٌوٚافل، ؽ١ش أْ ٌىً هافل ٚٚاكٞ  ث١ٓ (Watershed)َٔزؾؼو ِفَٙٛ فـٛؽ رم١َُ ا١ٌّبٖ 

 .ِٕبؿك رم١َُ ١ِبٖ ثّوٕٟ أْ الأِـبه اٌَبلـخ ٍٛف رَمؾ هٍٝ ٘نا اٌٛاكٞ

 

 : (Flow Accumulation) انًٛبِتحذٚذ يُبطك تزًغ  4-2-4

 

 ا7ٌٝ ثبٌن٘بة Flow Accumulation رُ هًّ اٌـ

Arc Toolbox > Spatial Analysis > Hydrology > flow Accumulation  

َّ ٍِف كٙود إٌبفنح اٌزب١ٌخ    In flow direction raster اٌغو٠بْ فٟ ارغبٖصُ اُكف

َّ ا  .Output accumulation rasterفٟ ٍُ َِٚبه اٌٍّف إٌبرظ هٓ اٌو١ٍّخ ٚاُكف
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 اتزبِ انتذفمبديُذخلاد ػًهٛخ  (7-4)سلىشكم ان

 

 : (Conانتحغٍٛ ) 4-2-5

 

 ا7ٌٝ ثبٌن٘بة  Conـرُ اٌم١بَ ثو١ٍّخ اٌ 

Arc Toolbox > Spatial Analyst Tools > Conditional > Con 

َّ اٌـ ) ٠ب ِو١ٓلاهلك ف)١خ فٟ َِبؽبد ِؾلكح أكفٍذ َِجمب اٌفوهمٌه ٌزؾل٠ل ثم١خ اٌّغبهٞ ٚ اُكف

Flow Accumulation Grid  َّ  Input true فٟٚ ١5333ّخ اٌم Expressionفٟ صُ اُكف

raster or constant value ٌٍّقوط  افزواػَِٟٚبه  اصُٚاٌجؤبِظ ؽَلك  " 5اٌم١ّخ "  اُكفٍَّذ

 . Output raster فٟ CON-Flow1ِٓ ٘نٖ اٌو١ٍّخ 

 

 

 : (Stream Link)سثط انشٔافذ  4-2-6

 

رزظً َِزٛٞ اٌق١ٍخ أٚ اٌوافل ٠ٚغت أْ  هٍٝفٟ ع١ّن اٌّواؽً اٌَبثمخ وبْ اٌوًّ 

 كٚادالأه ِٓ شو٠ؾ بفز١ا رُ ؛ ٌنااٌوٚافل كافً اٌٛاكٞ اٌٛاؽل

 Arc Toolbox >Spatial Analysis > Hydrology > Stream Link 
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هٕبطو اٌشجىخ ٚاهـبء وً ٔمـخ  اٌزمبء ٚٔمبؽث١ٓ اٌوٚافل  الارظبيٚمٌه ٌزؾل٠ل ٔمبؽ 

 .ِٕفوكحل١ّخ  ارظبي

 

 : ((Stream Orderحغبة انشتت انُٓشٚخ  4-2-7

 

 ا7ٌٟثبٌن٘بة  Stream Orderاٌـ رُ هًّ 

Arc Toolbox > Spatial Analysis Tools > Hydrology > Stream Order            

َّكٙود إٌبفنح    ؽُلك َِبه ٚ Input flow direction rasterفٟ اٌغو٠بْ  ارغبٍِٖف  اٌزب١ٌخ اُكف

أؽل ؿو٠مزٟ  افز١بهٚرُ  Output rasterفٟ إٌبرظ هٓ اٌو١ٍّخ  اٌٍّف ٚاٍُ

 .  Method of stream orderingفٟ (STRAHLER/SHREVE)اٌزظ١ٕف

 

 

 انشتت انُٓشٚخػًهٛخ  (8-4) سلى شكمان

 

 :(Stream to Feature)انتحٕٚم يٍ يهف شجكٙ نًهف خطٙ  4-2-8
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ٌٙنٖ  ٚاٌّلفلاد Stream to Feature الأِو ثبٍزقلاَ Vector اٌٍّف اٌشجىٟ اٌٝ فـٟ ؽُٛي

 Stream ٚف١ٙب رُ ٚػن اٌٍّف إٌبرظ هٓ اٌو١ٍّخ اٌَبثمخ Input Stream Feature اٌو١ٍّخ ٟ٘

Order َٚأِب Input Flow Direction َُِٚبه  اصُاٌغو٠بْ ٚاٌجؤبِظ ؽَلك  ارغبٖاكفبي ٍِف  ر

 .إٌبرظ اٌٍّف

 Grid Code ٚاٌؾمً Line ٚٔٛهٗ فؾ Shapefile ٔبرظ ٘نٖ اٌو١ٍّخ ٘ٛ ٍِف فـٟ فٟ طٛهح

 .٠زؼّٓ هرجخ اٌوافل ٚ٘ٛ

Arc Toolbox > Spatial Analysis Tools > Hydrology > Stream to Feature 

 

 

 يهف خطٙ شتت انُٓشٚخ انٗـتحٕٚم ان (9-4)سلى  شكمان

 

ٌٕفٌ  Editor ٚفوً شو٠ؾ اٌزؾو٠و point ِٓ إٌٛم ٔمـٟ Shape File فـٟ رُ هًّ ٍِف صُ

 .رغّن ا١ٌّبٖ ٌٍّغبهٞ اٌوئ١َ١خ فٟ ِٕـمخ اٌلهاٍخ ٚمٌه ٌزؾل٠ل ٔمبؽ ،اٌٍّف
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 :( Snap Pour Pointتحذٚذ انُمطخ ) 4-2-9

 7اٌن٘بة اٌٝ الأكٚاد رُِٓ شو٠ؾ 

Spatial Analyst Tools > Hydrology > Snap Pour Point 

  اٌوئ١َ١خ. اٌّغبهٞؿجمخ  ٝمبؽ اٌزٟ ؽلكد فٟ اٌٍّف اٌقـٟ هٍٚمٌه ٌٛػن إٌ

  

  :(Watershed) يغتزًؼبد انًٛبِ  4-2-11

 ا7ٌٝ ثبٌن٘بة  Watershedـفٟ ٘نٖ اٌّوؽٍخ رُ هًّ اٌ

Arc Toolbox > Spatial Analysis Tools > Hydrology> Watershed             

َّ فٟ   Flow Directionاٌـ  Input flow direction rasterكٙود إٌبفنح اٌزب١ٌخ صُ اُكف

 Outputإٌمـخ اٌّواك رىْٛ ِىبْ اٌَل ٚفٟ  Input raster or feature pour point dataٚفٟ

raster .رُ رؾل٠ل اٍُ َِٚبه اٌٍّف إٌبرظ هٓ اٌو١ٍّخ 

 

 

 يغتزًؼبد انًٛبِيُذخلاد  (11-4) سلىشكم ان
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 فٙ يُطمخ انذساعخيغتزًؼبد انًٛبِ  (11-4)شكم سلى ان

 

 :(Raster to Polygon) خطٙإنٗ يهف  انشجكخ انًبئٛخ يٍ يهف شجكٙ تحٕٚم 4-2-11

 ِٓ شو٠ؾ الأكٚاد رُ افز١به7

Conversion Tools > From Raster > Raster to Polygon 

  Vectorٍِف فـٟ  اٌٝ Raster إٌبرظ فٟ اٌقـٛح اٌَبثمخ ِٓ ٍِف شجىٟ اٌؾٛعٚمٌه ٌزؾ٠ًٛ 

 .فظبئظٗٔزّىٓ ِٓ ؽَبة َِبؽخ اٌؾٛع ٚكهاٍخ  ٝؽز
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 يٕلغ انغذ ثًُطمّ انذساعخ (12-4)سلى شكم ان
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 خبيظان جبةان

 دانخلاصخ ٔانتٕصٛب

 

 انخلاصخ: 5-1

إٌّـمخ اٌٛالوخ  ٟ٘ أفؼً ٔمـخ ٌزغ١ّن ا١ٌّبٖ فٟ ٚلا٠خ غوة كاهفٛه اٌٝ أْ ٘نٖ اٌلهاٍخ ظذفٍُ

أوضو ٔمـخ  َٔجخ لأٔٙباٌّزبفُ ٌوبطّخ اٌٛلا٠خ )ِل٠ٕخ اٌغ١ٕ١ٕخ(، ٚرُ افز١به٘ب ٚفٟ ألظٝ اٌغوة 

 .اٌَلِٕقفؼخ ِٕٚبٍجخ لإلبِخ 

 

 انتٕصٛبد: 5-2

 ِٟٕٙب فٟ كهاٍبد أفوٜ.زؾل٠ل الأؽٛاع اٌّبئ١خ ثىبًِ ِٕـمخ اٌلهاٍخ ٚالاٍزفبكح ث ٔٛط 

 ٚ ٠ؾز٠ٛٙب.اٌؾٛع اٌّبئٟ ٚؽَبة و١ّخ ا١ٌّبٖ اٌزٟ  ِؾ١ؾؽَبة َِبؽخ 

  ِٕفوكح.فظً وً ٚاكٞ هٍٟ ؽلا ٚكهاٍخ فظبئظٗ ثظٛهح 

 .اِىب١ٔخ الاٍزفبكح ِٓ اٌو١ٍّبد ا١ٌٙلهٌٚٛع١خ فٟ اٌزم١ًٍ ِٓ ِقبؿو إٌبرغخ ِٓ اٌف١ؼبٔبد 

  ض ٘نٖ الأؽٛاع صُ اٌّمبهٔخ ث١ٕٙبفظبئاِىب١ٔخ رؾل٠ل أوضو ِٓ ؽٛع ِبئٟ ٚكهاٍخ 

 ِٛلن لإلبِخ اٌَل. ٚافز١به أفؼً
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